Chapter 305

Tests for Two Total Variances in a $2 \times 2M$ Replicated Cross-Over Design

Introduction

This procedure calculates power and sample size of tests of total variabilities (between + within) from a $2 \times 2M$ replicated cross-over design for the case when the ratio assumed by the null hypothesis is one. This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the total variances.

This design is used to compare two treatments which are administered to subjects in different orders. The design has two treatment sequences. Here, $M$ is the number of times a particular treatment is received by a subject.

For example, if $M = 2$, the design is a $2 \times 4$ replicated cross-over. The two sequences might be

- sequence 1: C T C T
- sequence 2: T C T C

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout period between measurements.
Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 227 - 230.

Suppose \(x_{ijkl}\) is the response in the \(i\)th sequence \((i = 1, 2)\), \(j\)th subject \((j = 1, \ldots, Ni)\), \(k\)th treatment \((k = T, C)\), and \(l\)th replicate \((l = 1, \ldots, M)\). The mixed effect model analyzed in this procedure is

\[x_{ijkl} = \mu_k + \gamma_{ijkl} + S_{ijkl} + e_{ijkl}\]

where \(\mu_k\) is the \(k\)th treatment effect, \(\gamma_{ijkl}\) is the fixed effect of the \(l\)th replicate on treatment \(k\) in the \(i\)th sequence, \(S_{ij1}\) and \(S_{ij2}\) are random effects of the \(ij\)th subject, and \(e_{ijkl}\) is the within-subject error term which is normally distributed with mean 0 and variance \(V_k = \sigma^2_{Wk}\).

Unbiased estimators of these variances are found after applying an orthogonal transformation matrix \(P\) to the \(x\)’s as follows

\[z_{ijkl} = P'x_{ijkl}\]

where \(P\) is an \(m \times m\) matrix such that \(P'P\) is diagonal and \(\text{var}(z_{ijkl}) = \sigma^2_{Wk}\).

Let \(N_s = N_1 + N_2 - 2\). In a 2×4 cross-over design the \(z\)’s become

\[z_{ijkl1} = \frac{x_{ijkl1} + x_{ijkl2}}{2} = \bar{x}_{ijkl},\]

and

\[z_{ijkl2} = \frac{x_{ijkl1} + x_{ijkl2}}{\sqrt{2}} = \bar{x}_{ijkl}.\]

In this case, the within-subject variances are estimated as

\[s^2_{WT} = \frac{1}{N_s(M - 1)} \sum_{i=1}^{2} \sum_{j=1}^{N_i} \sum_{l=1}^{M} (z_{ijkl1} - \bar{z}_{lTl})^2\]

and

\[s^2_{WC} = \frac{1}{N_s(M - 1)} \sum_{i=1}^{2} \sum_{j=1}^{N_i} \sum_{l=1}^{M} (z_{ijkl2} - \bar{z}_{lCl})^2\]

Similarly, the between-subject variances are estimated as

\[s^2_{BT} = \frac{1}{N_s} \sum_{i=1}^{2} \sum_{j=1}^{N_i} (\bar{x}_{ijT.} - \bar{x}_{LT})^2\]

and

\[s^2_{BC} = \frac{1}{N_s} \sum_{i=1}^{2} \sum_{j=1}^{N_i} (\bar{x}_{ijC.} - \bar{x}_{LC})^2\]

where

\[\bar{x}_{i,k} = \frac{1}{N_i} \sum_{j=1}^{N_i} x_{ijkl}.\]
Now, since \( E(s_{BK}^2) = \sigma_{BK}^2 + \sigma_{WK}^2/M \), estimators for the total variance are given by
\[
\hat{\sigma}_{TK}^2 = s_{BK}^2 + \frac{(M - 1)}{M} \hat{\sigma}_{WK}^2
\]

The sample between-subject covariance is calculated using
\[
s_{BTC}^2 = \frac{1}{N_S} \sum_{i=1}^{2} \sum_{j=1}^{N_i} (\bar{x}_{ijT} - \bar{x}_{i.T})(\bar{x}_{ijC} - \bar{x}_{i.C})
\]

Using this value, the sample between-subject correlation is easily calculated.

### Testing Variance Inequality

The following three sets of statistical hypotheses are used to test for total variance inequality
\[
H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \geq 1 \text{ versus } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} < 1,
\]
\[
H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \leq 1 \text{ versus } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} > 1,
\]
\[
H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} = 1 \text{ versus } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \neq 1,
\]

Let \( \eta = \sigma_{TT}^2 - \sigma_{TC}^2 \) be the parameter of interest. The test statistic is \( \hat{\eta} = \hat{\sigma}_{TT}^2 - \hat{\sigma}_{TC}^2 \).

### Two-Sided Test

For the two-sided test, compute two limits, \( \hat{\eta}_L \) and \( \hat{\eta}_U \), using
\[
\hat{\eta}_L = \hat{\eta} - \sqrt{\Delta_L}
\]
\[
\hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U}
\]

Reject the null hypothesis if \( \hat{\eta}_L > 0 \) is or \( \hat{\eta}_U < 0 \).

The \( \Delta \)s are given by
\[
\Delta_L = h\left( N_s - \alpha, \frac{\alpha}{2}, N_s - 1 \right) \lambda_3^2 + h\left( 1 - \frac{\alpha}{2}, N_s - 1 \right) \lambda_2^2 + h\left( \frac{\alpha}{2}, N_s(M - 1) \right) \left[ \frac{(M - 1)\hat{\sigma}_{WT}^2}{M} \right]^2 \]
\[
+ h\left( 1 - \frac{\alpha}{2}, N_s(M - 1) \right) \left[ \frac{(M - 1)\hat{\sigma}_{WC}^2}{M} \right]^2
\]
\[
\Delta_U = h\left( 1 - \frac{\alpha}{2}, N_s - 1 \right) \lambda_3^2 + h\left( \frac{\alpha}{2}, N_s - 1 \right) \lambda_2^2 + h\left( 1 - \frac{\alpha}{2}, N_s(M - 1) \right) \left[ \frac{(M - 1)\hat{\sigma}_{WT}^2}{M} \right]^2 \]
\[
+ h\left( \frac{\alpha}{2}, N_s(M - 1) \right) \left[ \frac{(M - 1)\hat{\sigma}_{WC}^2}{M} \right]^2
\]
where

\[ h(A, B) = \left(1 - \frac{B}{\chi^2_{A,B}}\right)^2 \]

\[ \lambda_i^2 = \left(\frac{s_{BT}^2 - s_{BC}^2 \pm \sqrt{(s_{BT}^2 + s_{BC}^2)^2 - 4s_{BT}^4}}{2}\right) \text{ for } i = 1, 2 \]

and \( \chi^2_{A,B} \) is the upper quantile of the chi-square distribution with \( B \) degrees of freedom.

**One-Sided Test**

For the lower, one-sided test, compute the limit, \( \hat{\eta}_U \), using

\[ \hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U} \]

Reject the null hypothesis if \( \hat{\eta}_U < 0 \).

The \( \Delta_U \) is given by

\[ \Delta_U = h(1 - \alpha, N_s - 1)\lambda_1^2 + h(\alpha, N_s - 1)\lambda_2^2 + h(1 - \alpha, N_s(M - 1)) \left[\frac{(M - 1)\tilde{\sigma}_{WT}^2}{M}\right]^2 \]

\[ + h(\alpha, N_s(M - 1)) \left[\frac{(M - 1)\tilde{\sigma}_{WC}^2}{M}\right]^2 \]

**Power**

**Two-Sided Test**

The power of the two-sided test is given by

\[ \text{Power} = 1 - \Phi \left(z_{1 - \alpha/2} - \frac{(R_1 - 1)\sigma_{TC}^2}{\sqrt{\sigma^{*2}/N_s}}\right) + \Phi \left(z_{\alpha/2} - \frac{(R_1 - 1)\sigma_{TC}^2}{\sqrt{\sigma^{*2}/N_s}}\right) \]

where

\[ R_1 = \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \]

\[ \sigma_{TT}^2 = R_1 \sigma_{TC}^2 \]

\[ \sigma^{*2} = 2 \left[\left(\frac{\sigma_{BT}^2 + \sigma_{WT}^2}{M}\right)^2 + \left(\frac{\sigma_{BC}^2 + \sigma_{WC}^2}{M}\right)^2 + \frac{(M - 1)\sigma_{WT}^4}{M^2} + \frac{(M - 1)\sigma_{WC}^4}{M^2} - 2\frac{\sigma_{BT}^2 \sigma_{BC}^2 \rho^2}{M}\right] \]

where \( R_I \) is the value of the variance ratio stated by the alternative hypothesis and \( \Phi(x) \) is the standard normal CDF.

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary sample size.
One-Sided Test

The power of the lower, one-sided test, \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \geq 1 \) versus \( H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} < 1 \), is given by

\[
\text{Power} = \Phi\left( z_\alpha - \frac{(R_1 - 1)\sigma_{TC}^2}{\sqrt{\sigma^2/N_s}} \right)
\]

The power of the upper, one-sided test, \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \leq 1 \) versus \( H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} > 1 \), is given by

\[
\text{Power} = 1 - \Phi\left( z_{1-\alpha} - \frac{(R_1 - 1)\sigma_{TC}^2}{\sqrt{\sigma^2/N_s}} \right)
\]

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

Test Direction

Alternative Hypothesis

Specify whether the alternative hypothesis of the test is one-sided or two-sided.

Note that this parameter impacts the value of alpha. The value of alpha is used directly for one-sided tests. For two-sided tests, alpha is replaced by alpha/2.

Two-Sided Hypothesis Test

\[ H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} = 1 \text{ vs. } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \neq 1 \]

One-Sided Hypothesis Tests

Lower: \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \geq 1 \text{ vs. } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} < 1 \)

Upper: \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \leq 1 \text{ vs. } H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} > 1 \)
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of nonequivalent means when in fact the means are equivalent.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Sequence Allocation
Select the option that describes the constraints on $N_1$ or $N_2$ or both.

The options are

- **Equal ($N_1 = N_2$)**
  This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter $N_2$, solve for $N_1$**
  Select this option when you wish to fix $N_2$ at some value (or values), and then solve only for $N_1$. Please note that for some values of $N_2$, there may not be a value of $N_1$ that is large enough to obtain the desired power.

- **Enter $R = N_2/N_1$, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the ratio of $N_2$ to $N_1$, and then PASS determines the needed $N_1$ and $N_2$, with this ratio, to obtain the desired power. An equivalent representation of the ratio, $R$, is

\[ N_2 = R \times N_1. \]

- **Enter percentage in Sequence 1, solve for $N_1$ and $N_2$**
  For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then PASS determines the needed $N_1$ and $N_2$ with this percentage to obtain the desired power.
N2 (Sample Size, Sequence 2)
This option is displayed if Sequence Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
\[ R = \frac{N2}{N1}. \]
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.
N2 is related to N1 by the formula:
\[ N2 = \lceil R \times N1 \rceil, \]
where the value \( \lceil Y \rceil \) is the next integer ≥ Y.
For example, setting \( R = 2.0 \) results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single or a series of values.

Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for N1 and N2. Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Sequence Allocation
Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2.
The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**
  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Sequence 1**
  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as N - N1.
Sample Size Per Sequence

This option is displayed only if Sequence Allocation = “Equal (N1 = N2).”

The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same in each sequence, this value is the value for N1, and also the value for N2.

The Sample Size Per Sequence must be ≥ 2. You can enter a single value or a series of values.

N1 (Sample Size, Sequence 1)

This option is displayed if Sequence Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”

N1 is the number of items or individuals sampled from the Sequence 1 population.

N1 must be ≥ 2. You can enter a single value or a series of values.

N2 (Sample Size, Sequence 2)

This option is displayed only if Sequence Allocation = “Enter N1 and N2 individually.”

N2 is the number of items or individuals sampled from the Sequence 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.

R (Sequence Sample Size Ratio)

This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1.

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage of the total sample size in Sequence 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample size needs to be at least 4.

You can enter a single value or a series of values.

Percent in Sequence 1

This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”

This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.
Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design

**M (Number of Replicates)**
Enter one or more values for M: the number of replicates in a 2 × 2M replicated cross-over design. M is the number of times each treatment is measured on each subject.

For example, M = 2 refers to a 2 × 4 replicated cross-over design. The two sequences used for this design are often

*Sequence 1:* R T R T
*Sequence 2:* T R T R.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is M ≥ 2.

**Effect Size**

**R1 (Actual Variance Ratio)**
Enter one or more values for total variance ratio assumed by the alternative hypothesis. This is the value of $\sigma^2_{tt} / \sigma^2_{tc}$ at which the power is calculated.

The range of possible values is R1 > 0. R1 ≠ 1.

**$\sigma^2_{tc}$ (Control Variance)**
Enter one or more values for variance of the average subject control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{tc} > \sigma^2_{wc}$.

**$\sigma^2_{wt}$ (Treatment, Within-Subject Variance)**
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wt} > 0$.

**$\sigma^2_{wc}$ (Control, Within-Subject Variance)**
Enter one or more values for within-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is $\sigma^2_{wc} > 0$.

**ρ (Treatment, Control Correlation)**
Enter one or more values for the between-subject (intersubject) correlation. This is the correlation between the two group means, treatment and control, calculated on each subject. That is, the means are averaged across replicates within a subject.

This value will have to be determined from a previous study or a pilot study.

The range of possible values is $-1 \leq \rho \leq 1$.
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to compare it to the standard drug in terms of the total variability. A 2 x 4 cross-over design will be used to test the inequality using a two-sided test.

Company researchers set the significance level to 0.05, the power to 0.90, M to 2, and the actual variance ratio values between 0.5 and 1.3. They also set $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, $\sigma^2_{wc} = 0.3$, and $\rho = 0.7$. They want to investigate the range of required sample size values assuming that the two sequence sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab |  
Solve For | Sample Size
Alternative Hypothesis | Two-Sided (H1: $\sigma^2_{tt}/\sigma^2_{tc} \neq 1$)
Power | 0.90
Alpha | 0.05
Sequence Allocation | Equal (N1 = N2)
M (Number of Replicates) | 2
R1 (Actual Variance Ratio) | 0.5 0.7 0.9 1.1 1.3
$\sigma^2_{tc}$ (Control Variance) | 0.8
$\sigma^2_{wt}$ (Treatment Variance) | 0.2
$\sigma^2_{wc}$ (Control Variance) | 0.3
$\rho$ (Treatment, Control Correlation) | 0.7

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Seq 1 Sample Size</th>
<th>Seq 2 Sample Size</th>
<th>Num Reps</th>
<th>Actual Var Ratio</th>
<th>Total Var Cntl</th>
<th>Wthn Subj Var Cntl</th>
<th>Wthn Subj Var Trt</th>
<th>Wthn Cntl Var Cntl</th>
<th>Corr Trt vs Cntl</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9061</td>
<td>31</td>
<td>31</td>
<td>62</td>
<td>2</td>
<td>0.500</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.700</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9018</td>
<td>91</td>
<td>91</td>
<td>182</td>
<td>2</td>
<td>0.700</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.700</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>961</td>
<td>961</td>
<td>1922</td>
<td>2</td>
<td>0.900</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.700</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9000</td>
<td>1200</td>
<td>1200</td>
<td>2400</td>
<td>2</td>
<td>1.100</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.700</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9015</td>
<td>171</td>
<td>171</td>
<td>342</td>
<td>2</td>
<td>1.300</td>
<td>0.800</td>
<td>0.200</td>
<td>0.300</td>
<td>0.700</td>
<td>0.050</td>
</tr>
</tbody>
</table>

References


Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design

Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.
N1 is the number of subjects in sequence 1.
N2 is the number of subjects in sequence 2.
N is the total number of subjects. N = N1 + N2.
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a subject.
R1 is the value of the total variance ratio at which the power is calculated.
σ²tc is the total variance of measurements in the control group. Note that σ²tc = σ²wc + σ²wu.
σ²wu is the within-subject variance of measurements in the treatment group.
σ²wc is the within-subject variance of measurements in the control group.
ρ is the between-subject correlation of the average subject treatment-group measurements versus the average subject control-group measurements.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements
A study is being conducted to compare the total variance of a treatment group to a control group using a two-sided hypothesis test of data from a replicated cross-over design. Sequence sample sizes of 31 and 31 achieve 91% power to reject the null hypothesis at a significance level of 0.050. The variance ratio assumed by the null hypothesis is 1.0. The variance ratio at which the power is calculated is 0.500. The number of times each treatment measurement is repeated on a subject is 2. The actual total variance of the control group is assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 0.200. The actual within-subject variance of the control group is assumed to be 0.300. The between-subject correlation between the average treatment measurement per subject and the average control measurement per subject is assumed to be 0.700.

This report gives the sample sizes for the indicated scenarios.

Plot Section
This plot shows the relationship between sample size and R1.
Example 2 – Validation using Hand Calculations

We could not find an example in the literature, so we will present hand calculations to validate this procedure. Set \( N_1 = 20 \), significance level = 0.05, \( M = 2 \), and \( R_1 = 0.5 \). Also, \( \sigma^2_{tc} = 0.8 \), \( \sigma^2_{wt} = 0.2 \), \( \sigma^2_{wc} = 0.3 \), and \( \rho = 0.7 \).

Compute the power for the lower, one-sided test.

The calculations proceed as follows.

\[
\sigma^2_T = R_1(\sigma^2_{tc}) = 0.5(0.8) = 0.4
\]
\[
\sigma^2_B = \sigma^2_T - \sigma^2_W = 0.4 - 0.2 = 0.2
\]
\[
\sigma^2_C = \sigma^2_T - \sigma^2_W = 0.8 - 0.3 = 0.5
\]

\[
\sigma^2 = 2\left[\left(\frac{\sigma^2_B + \sigma^2_W}{M}\right)^2 + \left(\frac{\sigma^2_C}{M}\right)^2 + \frac{(M - 1)\sigma^2_W}{M^2} + \frac{(M - 1)\sigma^2_C}{M^2} - 2\sigma^2_B\sigma^2_C\rho^2\right]
\]

\[
\sigma^2 = 2\left[(0.2 + \frac{0.2}{2})^2 + \left(0.5 + \frac{0.3}{2}\right)^2 + \frac{0.04}{4} + \frac{0.09}{4} - 2(0.2)(0.5)(0.49)\right]
\]

\[
\sigma^2 = 2[0.09 + 0.4225 + 0.01 + 0.0225 - 0.0980] = 0.8940
\]

\[
\text{Power} = \Phi\left(z_{\alpha} - \frac{(R_1 - 1)\sigma^2_{tc}}{\sqrt{\sigma^2/\bar{N}_s}}\right)
\]

\[
\text{Power} = \Phi\left(-1.6448536 - \frac{(0.5 - 1)0.8}{\sqrt{0.8940/38}}\right)
\]

\[
\text{Power} = \Phi(-1.6448536 + 2.60785254)
\]

\[
\text{Power} = \Phi(0.96299894) = 0.83222597
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a 2×2M Replicated Cross-Over Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: ( \sigma^2_{tt}/\sigma^2_{tc} &lt; 1 ))</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Sequence Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Sequence</td>
<td>20</td>
</tr>
<tr>
<td>M (Number of Replicates)</td>
<td>2</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.5</td>
</tr>
<tr>
<td>( \sigma^2_{tc} ) (Control Variance)</td>
<td>0.8</td>
</tr>
<tr>
<td>( \sigma^2_{wt} ) (Treatment Variance)</td>
<td>0.2</td>
</tr>
<tr>
<td>( \sigma^2_{wc} ) (Control Variance)</td>
<td>0.3</td>
</tr>
<tr>
<td>( \rho ) (Treatment, Control Correlation)</td>
<td>0.7</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th></th>
<th>Seq 1 Sample Size</th>
<th>Seq 2 Sample Size</th>
<th>Num Reps M</th>
<th>Actual Var Ratio R1</th>
<th>Total Var Cntl Trt</th>
<th>Wthn Subj Var Cntl Trt</th>
<th>Wthn Subj Var Cntl Trt</th>
<th>Corr Trt Cntl Trt</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.8322</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>2</td>
<td>0.500</td>
<td>0.800</td>
<td>0.200</td>
<td>0.700</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The power matches the hand-calculated result.